Rutgers Editorial Style Guide

Department of University Communications and Marketing
Rutgers, The State University of New Jersey
communications.rutgers.edu
editorial@ucm.rutgers.edu

Revised November 1, 2018

RUTGERS
Contents
This PDF is entirely searchable. From the toolbar menu, choose Edit > Find or Search to begin your search. You can also click on an entry or page number below to jump to a particular section.

Introduction 3
References and Sources 3
Proper Names at Rutgers 4
- Rutgers, The State University of New Jersey 4
- Rutgers Entities 5
- Appropriate Rutgers Name 6
- Queen’s College and Old Queens 6
- School and College Names 7
- School/College/Center Abbreviations 10
- Other Unit Names 11
Academic Degrees 13
Addresses, States, Municipalities, and Countries 13
Alphabetization 14
Athletics 15
Capitalization 15
Gender-Neutral Language 18
Governing Boards 18
Italics 19
LGBTQIA Language 20
Numbers 20
- Telephone Numbers 22
Plurals and Possessives 22
Preferred Spellings, Capitalizations, and Usage 23
Punctuation 29
- Formatting Punctuation 29
- Periods, Other Terminal Punctuation, Colons 29
- Commas 29
- Dashes and Hyphens 30
- Hyphenation 31
- Parentheses 33
- Quotation Marks 33
- Semicolons and Colons 34
- Bulleted and Numbered Lists 34
Website Names and Web Addresses 35
State Government References 36
Style Guide Exceptions for Material Prepared for the News Media 37
Introduction

The following editorial guidelines have been developed for Rutgers, The State University of New Jersey, to lend consistency to text presentation in university communications.

The primary purpose of this guide is to address topics specific to Rutgers that may not be adequately covered in standard published style guides, such as *The Chicago Manual of Style* or *The Associated Press Stylebook*. In addition, the guide summarizes some of the most frequently raised questions of style—topics that are dealt with in greater detail in these manuals—in order to offer a quick, but more comprehensive, reference tool.

Questions of style, unlike many questions of grammar, usually do not have a “right” or “wrong” answer. Instead, establishing a “preferred” style is helpful so that a consistent presentation can be maintained throughout an array of materials that may be produced by many different individuals. Having a set of predetermined guidelines can also save those individuals the time and energy required to develop their own guidelines.

Exceptions to university style that apply to materials intended for distribution to the news media are found on page 37.

References and Sources

Note that editorial style reference works may contradict one another. In addition to the two primary sources listed below, many professional organizations have specialized style sheets for their specific disciplines, as do academic journals. Choose the style reference that is appropriate for your discipline and communications format.

Style Guides

  The creative services office of the Department of University Communications and Marketing relies primarily on this source. A revised (17th) edition, published in September 2017, is preferred but because the 17th edition may not be readily available at Rutgers, the 16th edition remains acceptable. The website is a useful resource, and the online subscription is an alternative to purchasing the book.

  Used for newspapers, media, etc. The university news and media relations office of the Department of University Communications and Marketing relies primarily on this source. An online subscription is an alternative to purchasing the book.

Dictionary

  Springfield, MA: Merriam-Webster Inc.
  When a spelling variation to the main entry is listed, preference is for the main entry.
Proper Names at Rutgers

Rutgers, The State University of New Jersey, is a public research university with three higher education institutions—Rutgers University–New Brunswick, Rutgers University–Newark, and Rutgers University–Camden—and an academic health care division, Rutgers Biomedical and Health Sciences, which collaborates universitywide and is aligned with Rutgers University–New Brunswick.

Rutgers, The State University of New Jersey

1. Capitalization: Note that the word “The” is capitalized

2. Punctuation:
   a. “Rutgers” is followed by a comma.
   
   b. When used in text, the full name of the university is followed by a comma, treating the phrase “The State University of New Jersey” as an appositive.

      Example: Rutgers, The State University of New Jersey, is the eighth oldest institution of higher learning in the United States.

   c. “The State University of New Jersey” as a stand-alone phrase is capitalized when beginning a sentence or when used later in a sentence.

      Example: Rutgers is The State University of New Jersey, and as such …

3. When to Use:

   The name “Rutgers, The State University of New Jersey,” should be used when referring to the university as a whole or to the central administration of the university. The full name should be used in copyright notices to ensure that appropriate rights and protections extend to the full university. The full name may also appear in website footers, addresses, or other instances where a formal designation is appropriate. The shortened form “Rutgers” is acceptable on subsequent references.

4. Possessive:

   a. To make the word “Rutgers” possessive, add an apostrophe only. Do not add an extra “s.”

      Example: Rutgers’ chess team was founded in 1768.

   b. When used as a possessive, the word “Rutgers’ ” is never preceded by “the.”

      Hint: If you are not sure whether “Rutgers” should be possessive in a particular usage, substitute a name that does not end in “s,” such as “Yale,” and see whether it makes sense or whether the substitution requires you to add an “’s,” e.g., “Yale’s.”
5. Adjective:
   
a. When used as an adjective, the word “Rutgers” may or may not be preceded by “the,” depending on the noun it modifies and the meaning of the sentence.
   
   Example: In general, Rutgers students are a loyal bunch. The Rutgers students did well.
   
b. When used as an adjective, the word “Rutgers” does not take an apostrophe.

Rutgers Entities

1. Rutgers University–New Brunswick on first reference; Rutgers–New Brunswick on subsequent references is acceptable.

   Rutgers Biomedical and Health Sciences, “division” may be added for clarity, e.g., the Rutgers Biomedical and Health Sciences division. This division collaborates universitywide and is aligned with Rutgers University–New Brunswick.

   Rutgers University–Newark on first reference; Rutgers–Newark on subsequent references is acceptable.

   Rutgers University–Camden on first reference; Rutgers–Camden on subsequent references is acceptable.

   a. Use a closed en dash between Rutgers University and the city (as is used above). Do not use an em dash (longer) or a hyphen (shorter). See Dashes and Hyphens on page 30.

2. Rutgers Health

   Rutgers Health is the clinical arm of Rutgers—the areas of Rutgers Biomedical and Health Sciences and other Rutgers units devoted to caring for patients. It’s a single brand for all of Rutgers' patient care and services. Rutgers Health is the most comprehensive academic health care provider in New Jersey, offering a breadth of accessible clinical care throughout the state supported by the latest in medical research and education.

3. Rutgers University–New Brunswick is made up of five smaller campuses:
   
   Busch campus
   College Avenue campus
   Douglass campus
   George H. Cook campus (G.H. Cook campus is also acceptable)
   Livingston campus

   a. Reference to the five smaller campuses is acceptable when writing for an internal audience at Rutgers. For external audiences, the preference is to use Rutgers University–New Brunswick.
b. Also used, especially on maps: Cook/Douglass campus (although these are considered to be two distinct campuses).

c. Note the appropriate alphabetical order of the campuses as listed above.

d. The word “campus” is not capitalized.

**Appropriate Rutgers Name**

1. The appropriate Rutgers name must appear somewhere in all official Rutgers communications.

2. When referring specifically to Rutgers University–New Brunswick, Rutgers Biomedical and Health Sciences, Rutgers University–Newark, Rutgers University–Camden, or Rutgers Health, identify it as such and use the correlating logo/signature. The Rutgers and Rutgers, The State University of New Jersey, logos/signatures should be used for communications from/about the central administration and governing boards or when referencing more than one entity.

**Queen’s College and Old Queens**

1. Queen’s College refers to the original name of Rutgers. Note that there is an apostrophe in Queen’s College.

2. Old Queens Campus is acceptable if in a historical reference; otherwise, do not use. Note that there is no apostrophe in Old Queens Campus.

3. Old Queens Building is acceptable. When referring to the building on second reference, Old Queens is acceptable. Note that there is no apostrophe in Old Queens Building or Old Queens.
School and College Names

As of August 1, 2018, there are 29 schools and colleges at Rutgers, The State University of New Jersey. Note that the word “Rutgers” is formally part of the name of some of the schools (Rutgers Business School–Newark and New Brunswick, Rutgers Law School, Rutgers School of Dental Medicine) and not formally part of the name of others. “Rutgers” may be placed before the name of the school or college in the latter case at the discretion of the writer.

1. Camden College of Arts and Sciences
2. Edward J. Bloustein School of Planning and Public Policy
3. Ernest Mario School of Pharmacy
4. Graduate School–Camden
5. Graduate School–Newark
6. Graduate School of Applied and Professional Psychology
7. Graduate School of Education
8. Mason Gross School of the Arts
9. New Jersey Medical School
10. Robert Wood Johnson Medical School
11. Rutgers Business School–Newark and New Brunswick (see Note 1 on page 8)
12. Rutgers Law School †
13. Rutgers School of Dental Medicine
14. School of Arts and Sciences
15. School of Arts and Sciences–Newark (see Note 2 on page 8)
16. School of Business–Camden
17. School of Communication and Information
18. School of Criminal Justice
19. School of Engineering
20. School of Environmental and Biological Sciences
21. School of Graduate Studies ††
22. School of Health Professions
23. School of Management and Labor Relations
24. School of Nursing
25. School of Nursing–Camden
26. School of Public Affairs and Administration
27. School of Public Health
28. School of Social Work
29. University College–Camden

† The School of Law–Newark and School of Law–Camden were merged and became Rutgers Law School on July 31, 2015. The law school has two locations. There is a co-dean of the Rutgers Law School in Newark and a co-dean of the Rutgers Law School in Camden.

†† The Graduate School–New Brunswick and Graduate School of Biomedical Sciences were merged and became the School of Graduate Studies on July 1, 2017.
Note: Degree-Granting Units

1. Rutgers Business School–Newark and New Brunswick

Rutgers Business School–Newark and New Brunswick is the preferred umbrella name used in most cases to identify students, faculty, programs, etc., connected to the university’s three formal degree-granting units that offer business programs in Newark and New Brunswick:

   Rutgers Business School: Undergraduate–Newark
   Rutgers Business School: Undergraduate–New Brunswick
   Rutgers Business School: Graduate Programs–Newark and New Brunswick

In general, use “Rutgers Business School–Newark and New Brunswick.” You may use the formal nomenclature if preparing a formal report for a chancellor or vice president, for instance, and you need to make a distinction between programs. But for general audiences use the umbrella name. To make distinctions, consider specifying “the bachelor of science program at Rutgers Business School–Newark and New Brunswick,” for example. Never use “Rutgers Business School–Newark” or “Rutgers Business School–New Brunswick.”

2. School of Arts and Sciences–Newark

School of Arts and Sciences–Newark incorporates two degree-granting units:

   Newark College of Arts and Sciences
   University College–Newark
1. School names do not include “The” (cap “T”) as part of their name. You may, however, when appropriate, use “the” (lowercase “t”) to precede the name.

2. The word “Rutgers” before the name of a school or college may or may not include an apostrophe depending on the writer’s preference. Notable exceptions are Rutgers Business School–Newark and New Brunswick, Rutgers Law School, and Rutgers School of Dental Medicine, which never take an apostrophe.

   Examples: Rutgers’ School of Criminal Justice is based in Newark. The professor presented his seminar at the Rutgers School of Social Work.

3. Use a closed en dash in the name of the school. Do not use an em dash (longer) or a hyphen (shorter).

   Examples: University College–Camden, Graduate School–Newark

   See Dashes and Hyphens on page 30 for details and instructions on how to insert the dashes into your document. Also, see Style Guide Exceptions for Material Prepared for the News Media on page 37.

4. Always use the full name of the school or college on first reference. On second reference and thereafter, it is preferable to use “the school” or “the college,” with distinctions made if necessary, e.g., “the psychology school.” Avoid abbreviations (acronyms and initialisms) on second, and later, references.

   On second reference, Mason Gross is acceptable for the Mason Gross School of the Arts and the Bloustein School is acceptable for the Edward J. Bloustein School of Planning and Public Policy.

5. If you must use an abbreviation in text for brevity’s sake, reference the full name at the first mention, followed by the abbreviation (acronym or initialism) in parentheses. Contact the dean’s office of the school or college to determine the preferred acronym or initialism.

   See School/College/Center Abbreviations on page 10.
**School/College/Center Abbreviations**

1. Use abbreviations (acronyms and initialisms) sparingly. The preference is to spell out school, college, center, and institute names in full and to avoid using acronyms, initialisms, or shortened names. An acronym is formed from a series of letters read as a word (e.g., CAIT, for Center for Advanced Infrastructure and Transportation), while an initialism is formed from a series of letters read as a series of letters (e.g., CCAS, for Camden College of Arts and Sciences).

   It is preferable to use “the school” on second reference, with distinctions made if necessary, e.g., “the psychology school.” Although schools and colleges tend to rely on acronyms and initialisms in their own materials, be mindful that readers may not understand the abbreviations and that full names immediately convey the scope and nature of the school.

   Example: The School of Arts and Sciences is the largest unit at Rutgers University–New Brunswick. Enrollment at the school exceeds 20,000.

   Note: On second reference, Mason Gross is acceptable for the Mason Gross School of the Arts and the Bloustein School is acceptable for the Edward J. Bloustein School of Planning and Public Policy.

2. When referring to a center or institute, it is preferable to refer to “the center” or “the institute” on second reference. Rely on abbreviations only when dealing with more than one center or institute. If you need to use the abbreviation for brevity’s sake, reference the full name at the first mention, followed by the abbreviation (acronym/initialism) in parentheses.

   Examples: Catherine studied under a faculty member at the Institute for Advanced Materials, Devices, and Nanotechnology. The institute was established in 2005.

   The Center for American Women and Politics (CAWP) and the Center for Women’s Global Leadership (CWGL) jointly sponsored the seminar. CAWP hosted the Friday sessions, and CWGL sponsored the Saturday sessions.

3. When referring to alumni with school/college and year of graduation, abbreviations are acceptable. When citing a person’s school or college and year of graduation after his or her name, use the abbreviation for the school, followed by an apostrophe and the last two digits of the year.

   Examples: John Smith GSE’56; John GSE’56 and Jane DC’58 Smith

   For clarity, use the whole year when referring to class years from past centuries, especially if it may not be clear to the reader based on the context.

   Example: Paul Robeson RC1919
4. School and College Abbreviations

Use the following abbreviations when referring specifically to alumni with school or college and year of graduation. For guidance regarding abbreviations for schools and colleges from earlier years at Rutgers, contact the Department of Alumni Relations, 848-932-7490.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC</td>
<td>Cook College</td>
</tr>
<tr>
<td>CCAS</td>
<td>Camden College of Arts and Sciences</td>
</tr>
<tr>
<td>CLAW</td>
<td>School of Law–Camden</td>
</tr>
<tr>
<td>DC</td>
<td>Douglass College</td>
</tr>
<tr>
<td>ED</td>
<td>School of Education</td>
</tr>
<tr>
<td>EJB</td>
<td>Edward J. Bloustein School of Planning and Public Policy</td>
</tr>
<tr>
<td>ENG</td>
<td>School of Engineering</td>
</tr>
<tr>
<td>GSAPP</td>
<td>Graduate School of Applied and Professional Psychology</td>
</tr>
<tr>
<td>GSBS</td>
<td>Graduate School of Biomedical Sciences</td>
</tr>
<tr>
<td>GSC</td>
<td>Graduate School–Camden</td>
</tr>
<tr>
<td>GSE</td>
<td>Graduate School of Education</td>
</tr>
<tr>
<td>GSM</td>
<td>Graduate School of Management</td>
</tr>
<tr>
<td>GSN</td>
<td>Graduate School–Newark</td>
</tr>
<tr>
<td>GSNB</td>
<td>Graduate School–New Brunswick</td>
</tr>
<tr>
<td>LC</td>
<td>Livingston College</td>
</tr>
<tr>
<td>MGSA</td>
<td>Mason Gross School of the Arts</td>
</tr>
<tr>
<td>NCAS</td>
<td>Newark College of Arts and Sciences</td>
</tr>
<tr>
<td>NJDS</td>
<td>New Jersey Dental School</td>
</tr>
<tr>
<td>NJIMS</td>
<td>New Jersey Medical School</td>
</tr>
<tr>
<td>NLAW</td>
<td>School of Law–Newark</td>
</tr>
<tr>
<td>NUR</td>
<td>College of Nursing</td>
</tr>
<tr>
<td>PHARM</td>
<td>Ernest Mario School of Pharmacy</td>
</tr>
<tr>
<td>QC</td>
<td>Queen’s College</td>
</tr>
<tr>
<td>RBS</td>
<td>Rutgers Business School–Newark and</td>
</tr>
<tr>
<td></td>
<td>New Brunswick</td>
</tr>
<tr>
<td>RC</td>
<td>Rutgers College</td>
</tr>
<tr>
<td>RLAW</td>
<td>Rutgers Law School</td>
</tr>
<tr>
<td>RSDM</td>
<td>Rutgers School of Dental Medicine</td>
</tr>
<tr>
<td>RWJMS</td>
<td>Robert Wood Johnson Medical School</td>
</tr>
<tr>
<td>SAS</td>
<td>School of Arts and Sciences</td>
</tr>
<tr>
<td>SASN</td>
<td>School of Arts and Sciences–Newark</td>
</tr>
<tr>
<td>SB</td>
<td>School of Business</td>
</tr>
<tr>
<td>SBC</td>
<td>School of Business–Camden</td>
</tr>
<tr>
<td>SC&amp;I</td>
<td>School of Communication and Information</td>
</tr>
<tr>
<td>SCILS</td>
<td>School of Communication, Information, and Library Studies</td>
</tr>
<tr>
<td>SCJ</td>
<td>School of Criminal Justice</td>
</tr>
<tr>
<td>SEBS</td>
<td>School of Environmental and Biological Sciences</td>
</tr>
<tr>
<td>SGS</td>
<td>School of Graduate Studies</td>
</tr>
<tr>
<td>SHP</td>
<td>School of Health Professions</td>
</tr>
<tr>
<td>SHRP</td>
<td>School of Health Related Professions</td>
</tr>
<tr>
<td>SMLR</td>
<td>School of Management and Labor Relations</td>
</tr>
<tr>
<td>SN</td>
<td>School of Nursing</td>
</tr>
<tr>
<td>SNC</td>
<td>School of Nursing–Camden</td>
</tr>
<tr>
<td>SPAA</td>
<td>School of Public Affairs and Administration</td>
</tr>
<tr>
<td>SPH</td>
<td>School of Public Health</td>
</tr>
<tr>
<td>SSW</td>
<td>School of Social Work</td>
</tr>
<tr>
<td>UCC</td>
<td>University College–Camden</td>
</tr>
<tr>
<td>UCN</td>
<td>University College–Newark</td>
</tr>
<tr>
<td>UCNB</td>
<td>University College–New Brunswick</td>
</tr>
</tbody>
</table>

Other Unit Names

1. Department and administrative office names at Rutgers are almost always “Department of” or “Office of.” Exceptions include the Rutgers University Police Department, Rutgers Athletics, Rutgers Recreation, and Rutgers University Libraries.

2. Capitalize the formal, full names of centers, bureaus, institutes, academic departments, administrative offices, and other formal groups, such as boards or committees. Use the full name of the unit on first reference. Lowercase shortened names used thereafter.

Examples: Department of History, but the history department; Department of English, but the English department; Office of the Dean, but the dean’s office; Board of Governors, but the board.
3. Make sure that the university affiliation (Rutgers University–New Brunswick, Rutgers University–Newark, Rutgers University–Camden, or Rutgers Biomedical and Health Sciences) of the group described is obvious from the context, e.g., the Department of Psychology at Rutgers University–Newark.

4. Rutgers Cancer Institute of New Jersey: Using the full name of the institute on the first reference is the preferred style. On second reference and thereafter, Cancer Institute of New Jersey is preferred. You may also use the Cancer Institute in subsequent references, but avoid abbreviations such as CINJ, except for limited internal communications.
**Academic Degrees**

1. **Degree Names:**

   Spell out all academic degrees: bachelor’s degree instead of B.A. or B.S., master’s degree instead of M.A. or M.S., doctoral degree instead of Ph.D., medical degree instead of M.D. Use either “doctorate” or “doctoral degree,” never “doctorate degree.” Use the word “degree” after the degree name for clarity. Note that the proper construction is “bachelor of arts degree” or “bachelor’s degree.” It is never “bachelor’s of arts degree.” Use abbreviations only if spelling out the degree is unwieldy or space is limited.

   Examples: bachelor’s degree, bachelor of arts degree, B.A. degree

2. **Lowercase academic degrees:** bachelor of arts degree in history

3. **Use periods in degree abbreviations.** However, if there is a strong preference for dropping the periods, drop consistently.

   Examples: B.A. and M.B.A., but BA and MBA

4. **Use italics for summa cum laude, magna cum laude, cum laude.**

5. **Academic Credentials:**

   Generally, avoid listing degrees and professional credentials after a person’s name (otherwise it can lead to alphabet soup). However, you may spell out his or her degree or provide a description.

   Examples: Jill Smith, who holds a doctor of pharmacy degree...; Samuel Simons, a physician who specializes in...

6. If it is essential to your communication to indicate doctoral designations, do so after the name by adding “M.D.,” “Ph.D.,” etc. Do not add “Dr.” before the name.

**Addresses, States, Municipalities, and Countries**

1. **Commas are used in text to set off individual elements in addresses and names of geographical places or political divisions.** The standard U.S. Postal Service abbreviation for a state or country should be used when providing addresses primarily for the purpose of mailing or in citations. (Use only one space, not two, between the state and the zip code.) Otherwise, states and countries should be spelled out in full. Note that “D.C.” in running text is used with periods but “DC” in an address for mailing purposes is used without periods.
Examples:
Please send all proofs to the editor at 25 Bentley Drive, New Brunswick, NJ 08901.
The plane landed in Nairobi, Kenya, that evening.
The company’s offices in Richmond, Virginia, were renovated recently.

2. When referring in general to a municipality, city, or state, the word “city” or “state” is not capitalized when it precedes a place name, but when referring specifically to an official governmental function/action of the municipality, city, or state, “city” or “state” is capitalized when it precedes the place name.

Examples:
Visitors to the city of New Brunswick will notice new Rutgers banners hanging from utility poles.
Rutgers serves residents throughout the state of New Jersey.
The City of New Brunswick approved Rutgers’ banner program at the council meeting.
The State of New Jersey issued new guidelines for teen drivers.

3. Rutgers return addresses should have a minimum of three lines. The bottom line should have the city, state, and zip code. The second line from the bottom should have the street address (and suite number, if any). The third line from the bottom should have Rutgers, The State University of New Jersey, or appropriate Rutgers name. The name of the building, if any, should appear on the fourth from the bottom line along with a room or floor number, if any. Other information, e.g., school, department, etc., should appear above that. Note that New Jersey is abbreviated (NJ) when used with a zip code. Note that “Street,” “Avenue,” etc., are spelled out in full.

Example:
School/Center
Building Name, Room or Floor (if any)
Rutgers, The State University of New Jersey (or appropriate Rutgers name)
Street Address, Suite Number (if any)
City, State Zip

**Alphabetization**

Preference is to use the letter-by-letter (as opposed to word-by-word) method to alphabetize.

Example of letter-by-letter order: Newark, New Brunswick, New York

Example of word-by-word order: New Brunswick, New York, Newark
Athletics

Style for commonly used athletics terms:

Big Ten or Big Ten Conference * (always spell out “Ten”; never use “10”)
Division I, Division II, Division III (use roman numerals)
HighPoint.com Stadium
NCAA (National Collegiate Athletic Association) *

A score of 6–8 (use an en dash)
Having a season record of 9-3 (use a hyphen)

* For questions regarding NCAA or Big Ten copyrights, trademarks, and other issues, contact Greg McCambridge [mailto:greg.mccambridge@rutgers.edu], assistant director for trademark licensing, Department of University Communications and Marketing.

Capitalization


2. Academic Subjects:

   Lowercase the names of subject areas in text, unless the name is a proper noun, such as French. Capitalize a subject when used as the name of a specific course or with its subject code or curriculum code.

   Examples: Sociology 01:920:201, Sociology 920. He double-majored in art and sociology.

3. University, College, and School:

   Lowercase university, college, and school unless they are used as part of a formal complete name.

   Examples: The School of Health Professions is part of Rutgers Biomedical and Health Sciences. The school offers majors in a wide variety of disciplines.

4. Titles of Organizations:

   Capitalize the formal, full names of centers, bureaus, institutes, academic departments, administrative offices, and other formal groups, such as boards or committees. Lowercase shortened names or casual references. Department and administrative office names at Rutgers are almost always “Department of” or “Office of.” Exceptions include the Rutgers University Police Department, Rutgers Athletics, Rutgers Recreation, and Rutgers University Libraries.
Examples: Department of History, but the history department; Department of English, but the English department; Office of the Dean, but the dean’s office; Board of Governors, but the board.

5. Titles of Persons:
   a. Lowercase titles of persons unless the title is used as an honorific with a last name.

   Examples: professor of English Richard Flunk, but Professor Flunk; campus dean Ellen Elroy, but Dean Elroy

   Exceptions: Board of Governors Professor, Distinguished Professor, University Professor, and other specific, unique titles should be capitalized so they are not confused with the generic “distinguished professor,” for example.

   Examples: Sarah Star, Board of Governors Distinguished Professor of History

   b. Use titles and positions (do not include degrees) to identify and explain someone’s academic or professional standing; a descriptive title adds more context to your communication.

   Examples: researcher and oceanographer Paul Pond; endocrinologist and chief of endocrinology Barbara Black

   c. Avoid honorifics (Mr., Mrs., Dr.). List someone’s full name on first reference and then use his or her last name.

   Example: Physicist Rorey Ideal was elected to the American Academy of Arts and Sciences. Ideal’s research focuses on the structure and properties of materials.

6. Headlines and Titles of Works:
   a. Capitalize the first and last words and all nouns, pronouns, adjectives, verbs, adverbs, and subordinate conjunctions. Lowercase articles, coordinate conjunctions, and prepositions (no matter how long). Also, see Style Guide Exceptions for Material Prepared for the News Media on page 37.

   b. With hyphenated compounds, always capitalize the first element. Subsequent elements are capitalized unless they are articles, prepositions, or coordinating conjunctions, or if the first element is a prefix.

7. “The” as Part of the Name of an Organization or Periodical:

Lowercase “the” in front of all formal titles unless you know that the organization insists on making the “the” a formal part of its title. “The” is not capped for Rutgers units. Note that the word “the” preceding a newspaper title is lowercased and not italicized. This is the case with all newspaper titles regardless of whether the word “the” appears on the newspaper’s masthead. Also, see Style Guide Exceptions for Material Prepared for the News Media on page 37.

Examples: He attended The Ohio State University and completed graduate work at the School of Criminal Justice at Rutgers University–Newark. He later worked for the New York Times.

8. Generic Term with Plural Proper Names:

The generic term in a proper noun is uppercased if used in the plural.

Examples: the Raritan and Millstone Rivers; the corners of Main and Washington Streets, the Departments of Economics, Environmental Sciences, and Geography

9. Academic Years:

Lowercase terms designating academic years. Because it is preferable to avoid gender-specific language, use “first-year student” in place of “freshman” if it does not change or make ambiguous the meaning of the sentence.

Examples: first-year student, freshman, senior, graduate student, postdoc

10. Specific Classes:

Treated collectively, specific classes can be considered a formal group and therefore capitalized.

Example: the Class of 1946

11. Racial, Ethnic, Religious, and Other Groups

Examples: Caucasian, Hispanic, Catholic, but black, white

12. Seasons of the Year:

Lowercase the four seasons (spring, summer, fall, winter)
**Gender-Neutral Language**

Avoid gender and other biased language that reasonable readers might find offensive or distracting unless, of course, the specific language is central to the meaning of the text. Achieving gender neutrality for generic references to people may involve rewording a sentence. There are several options to keep language concise and inclusive.

1. Avoid gender-specific words and phrases whenever possible.

<table>
<thead>
<tr>
<th>Use</th>
<th>Avoid</th>
</tr>
</thead>
<tbody>
<tr>
<td>chair</td>
<td>chairman/chairwoman/chairperson</td>
</tr>
<tr>
<td>humankind or humanity</td>
<td>mankind</td>
</tr>
<tr>
<td>police officer</td>
<td>policeman</td>
</tr>
<tr>
<td>first-year student*</td>
<td>freshman*</td>
</tr>
</tbody>
</table>

   * First-year student is preferred unless it changes the meaning of the text or makes it ambiguous. For example, in saying that “housing is guaranteed to all first-year students,” there is the possibility that readers may consider an upper-level transfer student to be a first-year student, when, in fact, housing is guaranteed only to freshmen.

2. Use “he or she” and “his or hers,” when appropriate. Avoid “he/she,” “s/he,” “his/hers.”

3. Replace a pronoun with an article
   - Original: Request that the employee submit her report.
   - Rewrite: Request that the employee submit the report.

4. Remove a pronoun altogether
   - Original: Ask the professor whether he is ready to begin class.
   - Rewrite: Ask whether the professor is ready to begin class.

5. Switch a gendered pronoun with “who”
   - Original: The doctor will be better prepared after she attends the conference.
   - Rewrite: A doctor who attends the conference will be better prepared.

The above examples apply to references where the identity of the person is unknown or unimportant. For reference about a specific person, writers should be sensitive to the fact that some individuals have a particular preference for the pronouns used to refer to them and should take this into consideration.

**Governing Boards**

Rutgers has several governing boards. The proper names of all governing boards should be capitalized: Board of Governors, Board of Trustees, the Rutgers University Senate; but the governors, trustees, senate, member of the Board of Governors, senator, etc. should
be lowercase. Governing boards at Rutgers are headed by a chair and vice chair; avoid using chairman, chairwoman, or chairperson.

**Italics**

Using italics for emphasis in text should be avoided as much as possible. Italics are used for the following:

1. Titles of books, journals, magazines, newspapers, reports, films, television programs (specific episodes are in quotation marks), blogs, podcasts, and brochures. (Article titles are placed in quotes. Academic course titles are placed in quotes when appearing in narrative text. See Quotation Marks on page 33.)

2. Media websites (newspapers, magazines, blogs, etc.). Follow formatting conventions for analogous print media, almost always italics. It is preferable to indicate when you are referring to the online version of media that also appears in print rather than including the URL.

   If you must include a media URL, format it in regular/roman, lowercased. Check the URL to be sure it is not case-sensitive.

   Examples:
   
   His comments appeared last year in the *Economist*.
   
   He writes for the online edition of the *Economist*.
   
   The article and comments are archived online at economist.com.
   
   NJ.com, the online home of 12 New Jersey newspapers, including the *Star-Ledger,* has launched a newly designed website.
   
   Rutgers Today is the official online source for universitywide news.

   Note: Rutgers Today, NJ.com, the Associated Press, etc. are not italicized.

3. Titles of musical recordings, like albums and CDs. (Song titles are placed in quotes. See Quotation Marks on page 33.)

4. Titles of paintings, photographs, sculpture, and other art. Also art exhibition titles.

5. Court cases.
   
   Example: *Miranda v. Arizona.* Also, the *Miranda* case.

6. Isolated words and phrases in other languages if they are likely to be unfamiliar to readers. Set in regular/roman if repeated. If a foreign language word is listed in the main body of *Webster’s,* it is assumed to be familiar enough not to warrant italics.

7. Scientific names of plants and animals. Capitalize genus, but not species and subspecies.
   
   Example: *Homo sapiens rutgersensis*
8. Terms with special meanings or slang may be italicized the first time they are used. Using quotation marks instead of italics is equally acceptable. Be consistent. Subsequent uses are in regular/roman.

9. References to words as words or letters as letters may be in italics. Using quotation marks instead of italics is equally acceptable. Be consistent.

Example: The word simply has other meanings. X marks the spot. Also acceptable: The word “simply” has other meanings. “X” marks the spot.

10. Letter grades.

Example: The average grade for the class was a B, but Lisa earned an A.

11. Use for summa cum laude, magna cum laude, cum laude.

LGBTQA Language

1. Use the term LGBTQA when referring to individuals who identify themselves as lesbian, gay, bisexual, transgender, queer, or ally. Using the initialism alone on first reference is acceptable if the audience is an informed audience. If the audience may not know what it means, then write it this way on first reference: LGBTQA (lesbian, gay, bisexual, transgender, queer, ally).

Example: A program run by the housing department is designed for LGBTQA (lesbian, gay, bisexual, transgender, queer, and ally) students. The LGBTQA community fully supports it.

2. Writers should be sensitive to the fact that some individuals have a particular preference for the pronouns used to refer to them and should take this into consideration.

Numbers

1. The general rule is to spell out cardinal and ordinal numbers through nine, i.e., zero through nine, and first through ninth. Use Arabic numerals for 10 and above, and 10th and above. This may cause a paragraph, or even a sentence, to have both words and numerals for numbers. This is fine. For example: She had three cats and 11 dogs.

Exceptions are made for academic credits, percentages, ages, heights, weights, and other dimensions.
a. For ordinal numbers, do not use superscript when typing 10th and above.

Example: He celebrated the publication of his 15th journal article, not 15th journal article.

2. Academic Credits: Expressed in numerals.

Examples: This is a 3-credit course. The major requires a total of 36 credits.

3. Percentages: Expressed in numerals, and the word “percent” is spelled out. An exception can be made for tables where the percent sign (%) can be used.

Example: The professor passed 80 percent of the class.


Example: a 3-year-old girl, she is 32 years old

5. Height, Weight: Use figures for all and spell out inches, feet, pounds, ounces, etc.

a. Hyphenate adjectival forms before nouns.

Examples: He is 5 feet, 10 inches tall. The baby weighed 5 pounds, 11 ounces. He is a 235-pound fullback. The 5-foot-10-inch runner. The 5-10 runner.


Example: Eighty percent of the class passed.

7. Times: Use numerals except for noon (12 p.m.) and midnight (12 a.m.).

a. Use a colon to separate hours from minutes: 11:15 a.m., 3:25 p.m.

b. Do not use :00 if the time is on the hour: 10 p.m. (An exception may be made in formal invitations: Please join us from 11:00 a.m. to 2:00 p.m.)

8. Dates: When citing a specific date, it is helpful to the reader to include the day of the week. Do not abbreviate the days of the week and months.

Examples: Thursday, May 16, 2019; September 2020; April 12 (not 12th or 12th)

9. Decades: the 1980s, the ’80s

10. Spell out numbers in casual expressions: Thanks a million.
**Telephone Numbers**

The preferred form for listing telephone numbers is the following:
732-445-3701, ext. 6409

732-445-3701 x 6301 is also acceptable if space is an issue.

**Plurals and Possessives**

1. The possessive case of singular nouns is formed by the addition of an “apostrophe s” (’s). The possessive case of plural nouns is formed by the addition of an apostrophe only. This applies to proper nouns and common nouns.

   Example: Jack’s car, Columbus’s ship, puppies’ tails

   Exception: Rutgers’. Use an apostrophe only with the word “Rutgers.” Do not add an extra “s.”

   Example: Rutgers’ football team (or the Rutgers football team), Rutgers’ students (or the Rutgers students). (Also see the Proper Names at Rutgers on page 4.)

   Note: The word “Rutgers” before the name of a school, college, center, institute, program, etc., may or may not include an apostrophe, depending on the writer’s preference. Notable exceptions are Rutgers Business School–Newark and New Brunswick, Rutgers Law School, and the Rutgers School of Dental Medicine, which never take an apostrophe.

   Examples: Rutgers’ School of Criminal Justice and Institute of Jazz Studies are based in Newark. The professor presented the seminar at the Rutgers New Jersey Medical School.

2. Single or multiple letters used as words and numbers form the plural by adding “s” alone, so far as it can be done without confusion.

   Example: earning three Bs, IOUs, the early 1920s

3. Abbreviations ending with a period form the plural with an “apostrophe s.”

   Example: Ph.D.’s, M.D.’s, Psy.D.’s

   If periods are dropped consistently for all degrees, however, form the plural by adding “s” alone.

   Example: MDs and MBAs
Preferred Spellings, Capitalizations, and Usage
Always use the preferred spelling (the first entry in the dictionary) when there is more
than one acceptable spelling listed. Example: toward, not towards.

A
AAU (Association of American Universities)
adviser (not advisor)
affect (see effect): Affect, as a verb, means to influence: The construction will affect
traffic for many months to come. Affect, as a noun, is rarely used. It means
emotional state: The patient’s depression was indicated by his flat affect.
African American (n.)
African-American (adj. before noun)
All-American
alum (f. or m., singular; use very sparingly and never in formal communications)
alumna (f., singular) Jane is an alumna of Douglass College.
alumnae (f., plural) Jane and Mary are alumnae of Douglass College.
alumni (m. or group of men and women, plural) The fraternity’s alumni came back to
campus for the event. Jane, Bill, and six other alumni attended the meeting.
alumnus (m., singular) Bill is an alumnus of the School of Social Work.
assure (see ensure and insure): Assure means to make sure or certain. He double-checked
to assure that the answers were correct.

B
Barnes & Noble at Rutgers
best seller (n.)
best-selling (adj. before noun)
Big Ten (always spell out “Ten”; never use “10”)
Big Ten Academic Alliance
black (person)
blog (n. and v.)

C
campuswide
catalog (not catalogue)
chair (not chairman, chairwoman, or chairperson)
child care (n. and adj.)
citizen (use only if someone has citizenship; rather, use “resident”)
CMS (content management system)
coadjutant (not coadjunct)
co-chair (this is an exception to the rule to close up words beginning with co)
co-dean (this is an exception to the rule to close up words beginning with co)
Cold War
colonial
coursework
craftsman, craftspeople
credits (not credit hours)
cross-cultural

*cum laude*

cumulative grade-point average
curriculum (singular), curricula (plural)

**D**
database
day care (n. and adj.)
decision-maker (n.)
decision-making (n. and adj.)
dial up (v.)
dial-up (adj.)
Division I, Division II, Division III
doctor (see *physician*)
dos and don’ts
dual degree (n.)
dual-degree (adj. before noun)

**E**
Earth (i.e., She returned to Earth.); the earth (i.e., She returned to the earth.)
ebusiness
ecommerce
effect (see affect): Effect, as a verb, means to accomplish: The new president effected many changes. Effect, as a noun, means result: The effect of the donation was dramatic.
email
emerita (f., singular) She is a trustee emerita of the board.
emeritae (f., plural) The women are trustees emeritae of the Women’s Science Coalition.
emeriti (m. or group of men and women, plural) John and Jane were trustees emeriti of the board.
emeritus (m., singular) John is a trustee emeritus of the board.
enewsletter
ensure (see assure, insure): Ensure means to guarantee: Steps were taken to ensure accuracy.

**F**
faculties (plural, when referring to faculty of more than one academic unit)
faculty (may be singular or plural for verb agreement; use “members of the faculty” if necessary to avoid awkward construction) Rutgers faculty [they] seek solutions for urgent problems. The Rutgers faculty [it] is known for excellence in research. Members of the faculty [they] are organizing the research symposium.
fall (the season)
FAQ (not FAQs) for Frequently Asked Questions
fieldwork
fifth-year student
first-year student
fiscal year 2019 (also FY2019; reserve FY for financial matters)
follow up (v.)
follow-up (n. and adj.)
friend (v.)
full time (after a verb)
full-time (adj. before a noun)
fundraise, fundraiser
fundraising (n. and adj.)
FY2019 (for financial matters; also fiscal year 2019)

G
google (v.)
grade-point average
groundbreaking

H
he or she (not he/she, s/he, or (s)he)
health care (n. and adj.)
HighPoint.com Stadium
high school (n. and adj.)
high-speed (adj. before noun)
high-tech (adj. before noun)
his or hers (not his/hers)
historic (having great and lasting importance)
historical (occurred in the past)
homepage

I
in-depth (adj. before noun)
inpatient
insure (see assure, ensure): Insure is reserved for insurance, i.e., paid policy.
internet

J
Jersey Shore
joint degree (n.)
joint-degree (adj. before noun)
jump start (n.)
jump-start (v.)

L
Latino/a, Latinx (a gender-neutral alternative)
life cycle
lifelong
life span
lifestyle
lifetime
livestream
log in (v.)
login (adj. and n.)
long-standing (adj. before noun)
long-term (adj. before noun)

M
magna cum laude
microblog
minicourse
modeled, modeling
multimedia
myRutgers

N
NCAA (National Collegiate Athletic Association)
NetID
North Jersey (but northern New Jersey)

O
on campus (after a verb)
on-campus (adj. before a noun)
online
on site (after a verb)
on-site (adj. before a noun)
on the Banks
outpatient

P
part time (after a verb)
part-time (adj. before a noun)
password
PDF (Portable Document Format)
physician (preferred over doctor when referring to a medical doctor)
physician assistant (not physician’s assistant)
podcast
policymaker or policymaking (n.)
policy-making (adj.)
postdoc
prelaw
premedicine
preveterinary
problem solving (n.)
problem-solving (adj.)
R
reentry
résumé
retweet

S
screen-saver
semester (preferred usage; see term)
sign up (v.)
sign-up (n. and adj. before noun)
social media
Social Security Number
socioeconomic
South Jersey (but southern New Jersey)
spin off (v.)
spin-off (n. and adj. before noun)
spring (the season)
start-up (n. and adj.) (fledgling business)
state house (New Jersey State House) (see State Government References on page 36)
statewide
stem cell research
streaming
student-athlete
summa cum laude
summer
supply chain management
symposia (pl.); symposium (sing.)

T
term (generally only used when referring to term bills; otherwise, use semester)
theater
3-D or 4-D (n. and adj.) (but 3D-printed object to avoid two hyphens)
time frame
timetable
tollbooth
totaled, totaling
trade-off (n.)
turfgrass
tweet

U
underway
universitywide
URL (Uniform Resource Locator; i.e., an individual web address)
username
V
v. (in title of a court case)
versus (not vs.)
vice chair
vice president

W
WeatherWatchers
web
webcast
webpage
website
West Coast
white (person)
Wi-Fi
wiki
winter
workforce
workplace
work study (n.)
work-study (adj.)
worldwide
World Wide Web

Z
zip code
Punctuation

Formatting Punctuation

Periods, exclamation points, commas, colons, semicolons, hyphens, and other internal and terminal punctuation should be set in the type style (e.g., bold, italic, regular/roman, color) of the preceding word.

Examples: The professor was quoted in the *New York Times*. The prize went to *Volcanoes of the Deep*, a film coproduced by Rutgers. **Contact your adviser immediately!**

An exception is when a web address comes at the end of a sentence. If the web address is formatted in bold or color, the ending punctuation should remain unformatted (to distinguish it from the URL).

Periods, Other Terminal Punctuation, Colons

1. Use only one space between sentences after a period, question mark, or exclamation point.

2. Use only one space after a colon in a sentence.

   Example: She carried three things: a ball, a bat, and a mitt.

Commas

1. Series or Serial Comma: Use a comma after each element in a series of three or more. Also, see Style Guide Exceptions for Material Prepared for the News Media on page 37.

   Example: students, faculty, and administration

   Exception: We discourage the use of ampersands (&). However, if an ampersand must be used, there is no comma before an ampersand.

   Example: housing, dining & transportation

2. Title abbreviations following a person’s name, such as Jr. and Sr., and roman numerals are not set off by commas.

   Example: John J. Jones Sr. and John J. Jones III were poor, but John E. Jones made a lot of money.

3. Use commas to set off a word or phrase in apposition, unless it has an essential identifying function. (Apposition is when two usually adjacent nouns referring to the
same thing are used in a sentence and are essentially interchangeable. In the example below, the person has one wife, Mary; there is no confusion about which wife is referred to, so Mary does not serve an essential identifying function for “my wife” and is set off by commas. The person does have more than one friend, however, so John does serve an essential identifying function for “my friend” and is not set off by commas.)

Example: My wife, Mary, arrived but my friend John did not.

4. In dates, commas are not used to mark off the month and year. If the day is included, the year is set off by commas before and after.

Examples: The meetings were held in April 1967. The events of April 18, 1775, have been celebrated in song and story.

5. Use commas after both a city and state when both are given.

Example: He lived in Bedford Hills, New York, before moving to Georgia.

**Dashes and Hyphens**

There are three common dashes of differing lengths used in formatted copy: em dash (—), en dash (–), and hyphen (-). The em dash is the longest (the width of an uppercase “M” in the typeface and size being used, which is usually also the point size). The en dash is half the length of the em dash. The hyphen is the shortest. Also, see Style Guide Exceptions for Material Prepared for the News Media on page 37.

1. **Em dash:**
   Use an em dash to denote an abrupt change in thought or to set off an element added for emphasis, explanation, or digression. The em dash should be typeset closed, i.e., with no extra space before or after the em dash.

   Example: Tens of thousands of previously unknown proteins—revealed to scientists through the mapping of the human genome—may point the way to the discovery of new drugs to treat disease.

   Note: To insert an em dash in Word:
   PCs: From the menu, choose Insert > Symbol/Special Character, then choose the em dash (the larger of the two dash options). The shortcut is Alt + Control + Numberpad Minus Sign (-).

   MACs: From the menu, choose Insert > Advanced Symbol, then choose the em dash (the larger of the two dash options). The shortcut is Command + Option + Numberpad Minus Sign (-).
2. **En dash:**
   a. An en dash is used to separate a range of inclusive dates and numbers. The en dash should be typeset closed, i.e., with no extra space before or after the en dash.


   b. An en dash is used in sports scores and should be typeset closed.

   Example: a score of 6–8

   c. Rutgers uses the en dash in school and university names and should be typeset closed.

   Example: Graduate School–Camden, Rutgers University–New Brunswick

Note: To insert an en dash in Word:
PCs: From the menu, choose Insert > Symbol/Special Character, then choose the en dash (the smaller of the two dash options). The shortcut is Control + Numberpad Minus Sign (−).

MACs: From the menu, choose Insert > Advanced Symbol, then choose the en dash (the smaller of the two dash options). The shortcut is Command + Numberpad Minus Sign (−).

3. **Hyphen:**
   a. Used to form compound words (see Hyphenation, below).
   b. Used in phone numbers, e.g., 732-445-3710 (see Telephone Numbers on page 22).

**Hyphenation**

1. Modern usage tends toward the closing of prefixes and of compound words that used to be hyphenated. Check the dictionary. (Also see Preferred Spellings on page 23.)

2. Compound adjectives that are hyphenated before a noun are open after a noun.

   Examples: full-time student, the student is full time; on-campus housing, living in housing on campus

3. Adjectival phrases are hyphenated before the noun and are usually open after a noun.

   Examples: up-to-date list, list is up to date; state-of-the-art equipment, equipment is state of the art

4. Other compound adjectives may or may not be hyphenated.
a. Hyphens should be used to avoid ambiguity.

Examples: personal-computer program, slow-moving van

b. If the meaning of the compound adjective is a universally understood expression, no hyphen is needed.

Examples: health care system, high school classroom

c. Less common expressions are better hyphenated.

Example: joint-degree program

5. Use hyphens with nouns that represent different and equally important functions when they form a single expression.

Example: student-athlete

6. A hyphen is used after the first of two prefixes or after the first element in a “double” compound adjective.

Example: Macro- and microeconomics, fourth- and fifth-century art (but established in the fifth century)

7. Do not hyphenate an adverb ending in “ly” before an adjective.

Example: highly popular musician

8. Compound adjectives where the second adjective ends in “ed” are hyphenated.

Example: good-natured proofreader

9. The following prefixes generally are not hyphenated:

<table>
<thead>
<tr>
<th>ante</th>
<th>infra</th>
<th>mini</th>
<th>pre</th>
<th>super</th>
</tr>
</thead>
<tbody>
<tr>
<td>anti</td>
<td>inter</td>
<td>multi</td>
<td>pro</td>
<td>trans</td>
</tr>
<tr>
<td>bi</td>
<td>intra</td>
<td>neo</td>
<td>re</td>
<td>ultra</td>
</tr>
<tr>
<td>co</td>
<td>macro</td>
<td>non</td>
<td>semi</td>
<td>un</td>
</tr>
<tr>
<td>counter</td>
<td>micro</td>
<td>over</td>
<td>socio</td>
<td>under</td>
</tr>
<tr>
<td>extra</td>
<td>mid</td>
<td>post</td>
<td>sub</td>
<td></td>
</tr>
</tbody>
</table>

Exceptions: (a) when the second element is capitalized or is a figure, e.g., mid-July, pre-1960s; (b) when there is a homonym, e.g., recover a lost object, but re-cover a couch; (c) for clarity, when it creates a strange spelling connection (co-chair, not cochair; co-dean, not codean); and (d) when there are repeated vowels, such as anti-intellectual or co-op.
10. Ewords: Many expressions are cropping up with the letter “e” preceding a familiar word. We recommend closing all such expressions and lowercasing the word immediately following the “e” prefix.

Examples: ebusiness, ecommerce

Note that the “e” in such terms is capitalized when the term appears in a headline, as a stand-alone head, and at the beginning of a sentence.

Example: Ecommerce is important to success in the retail marketplace.


12. All “self” compounds are hyphenated except when the addition is a suffix.

Examples: self-confident, self-reliant, but selfless and selfish

13. Compounds with “well” are hyphenated before the noun unless the expression carries a modifier. Do not use a hyphen if the compound appears after the verb.

Examples: well-intentioned person, but very well known man. She is well known.

14. Suffixes are rarely hyphenated.

Examples: statewide, campuswide, universitywide

**Parentheses**

No punctuation should be used before an opening parenthesis. All punctuation except terminal punctuation, such as a period, question mark, or exclamation point, should be dropped before a closing parenthesis.

**Quotation Marks**

1. All punctuation marks except the colon and semicolon are placed within quotation marks.

Example: He heard what he described as a “very loud and disturbing growl.” “This is crazy,” she said.

2. Use double quotation marks for quoted words, phrases, and sentences that are not set apart in block quotations. Use single quotation marks to enclose quotes within quotes.

Example: “Then, for an encore, he sang ‘Yesterday.’”
3. Article, dissertation, song, and TV episode titles are placed in quotes. (See Italics for styles of other titles on page 19.)

4. Academic course titles are placed in quotes when appearing in narrative text.

**Semicolons and Colons**

1. The first word of a sentence following a semicolon or the first word of a sentence or list following a colon within a sentence should be lowercased. Use only one space after a semicolon or colon.

2. Use a semicolon in lists of names or titles or in other lists that would not be clear if separated by commas only.

   Examples: Her work combines elements of environmental, civil, and mechanical engineering; human and animal biology; and sociology.

   They came from Mendon, Utica, and Point Lookout, New York; Springfield, East Brunswick, and Newark, New Jersey; and Newton, Worcester, and Hull, Massachusetts.

**Bulleted and Numbered Lists**

1. A vertical list is best introduced by a complete grammatical sentence, followed by a colon. After each bullet or number, each entry should start with a capital letter. The entries should carry no punctuation at the end, unless they are complete sentences. Do not mix complete sentences with nonsentences. Also be consistent and parallel in construction on bulleted items: if one begins with a verb, they all should. Another consideration is to alphabetize the list if the list is in no particular order.

   Examples:

   Other online innovations have also been developed:
   • Financial aid application
   • Financial aid awards
   • Financial aid requests for documentation
   • Loan counseling
   • Loan promissory notes
   • Online student survey to measure service quality

   Compose three sentences to do the following:
   1. Illustrate the use of commas in dates.
   2. Distinguish the use of semicolons from the use of periods.
   3. Demonstrate knowledge of the em dash.
2. A vertical list that comprises, with its introduction and entries, a complete sentence begins with an introductory statement followed by numbers or bullets. Each entry starts with a lowercase letter and is followed by a semicolon. A period should follow the final entry.

Example:

We also consider such qualitative factors as
- extracurricular activities;
- community, volunteer, or U.S. military service;
- honors and awards;
- employment;
- family obligations;
- special talents; and
- socioeconomic background.

Note: The above styles for punctuating lists are recommendations. One has flexibility in choosing styles for punctuating lists. The goal should be to punctuate lists with style consistency throughout a document or website.

**Website Names and Web Addresses**

1. Website names are set in roman with headline style.

2. Avoid including http:// when listing a URL for websites. Rather, state clearly that the address is a web address. Include www. only if it is required by the specific website.

   Example: Please visit oirap.rutgers.edu on the web.

3. Do not underline URLs. Do not format URLs in italics. If you want to draw attention to a URL in a printed piece, consider using bold or a color. There is not a specific style, since the best choice may vary depending on the design of the publication. For the most part, URLs should be lowercased; check the URL to be sure it is not case-sensitive.

4. It is strongly preferred not to break a URL at the end of a line of text. If possible, rewrite the text to avoid this. If a web address must be broken between two lines, be sure that a hyphen or space is not added inadvertently at the break point.

5. When a URL falls at the end of a sentence, it should be followed by a period. It is assumed that it is common knowledge that the period is not part of the URL. Should you wish to emphasize this and your URL is formatted in bold or in a color, then the period should revert to the previous (often regular/roman or black) type. (This contradicts standard formatting, which calls for punctuation to be set in the type style of the preceding word.)
State Government References

1. The proper name of the meeting place of the New Jersey legislature in Trenton is the New Jersey State House. Note that “state house” is two separate words, not “statehouse,” as you would find in the dictionary. Use lowercase in generic references.

   Examples:
   The meeting took place at the New Jersey State House.
   The state house is a popular field trip destination for New Jersey schoolchildren.

2. When referring to another state’s legislative meeting place, research the proper name.

   Example: Maryland State House, Ohio Statehouse, Kentucky State Capitol, State Capitol of Pennsylvania


   Example: Governor Phil Murphy visited Rutgers on Tuesday. The governor announced the creation of a task force on school security.
Style Guide Exceptions for Material Prepared for News Media

The following exceptions to university style apply to materials intended for distribution to the news media. News organizations adhere to Associated Press (AP) style. Using AP style decreases the likelihood of copy errors.

**Comma, in a series:**
Use commas to separate elements in a series, but do not put a comma before the conjunction in a simple series. The flag is red, white and blue.

But if an integral element of the series requires a conjunction, place a comma before the concluding conjunction. I want orange juice, toast, and ham and eggs for breakfast.

**Governor:**
Use the abbreviation Gov. with a proper name. Gov. Phil Murphy

**Hyphenation and Dashes:**
School names: Use a hyphen in school names and university names. Do not insert spaces before or after the hyphen.

Example: Graduate School-Camden, Rutgers University-Newark

Use a hyphen to separate inclusive dates and numbers. Do not insert spaces before or after the hyphen.


Use dashes within a sentence to set off a phrase or change in thought. Insert spaces before and after the dashes.

Example: The president listed qualities – intelligence, honesty, humor – that she liked in an assistant.

**Months:**
Abbreviate the following months when used with a specific date: Jan., Feb., Aug., Sept., Oct., Nov., and Dec. Spell out all months when using alone, or when using with a year and no specific date.

**Headline Style:**
Capitalize all words except conjunctions and prepositions of 3 or fewer letters.

**Periodical Titles:**
Capitalize “the” in the name of a periodical if that is the way the publication prefers to be known. Check the masthead if in doubt.

Example: *The New York Times*